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File menu commands
The File menu offers the following commands :

Open...
Encode As...
Exit



Open... command
Use this command to open an AVI or MPEG Source.

When an AVI Source is opened, the entire sequence is automatically selected (outlined in 
pink on the Timeline ).

MPEG Maker 2 allows to visualize an MPEG source, in such case the File/save as.., 
Parameters/Encoding.. commands and selection markers will be disabled (grayed)

Only one source may be opened at a time. Opening a new source will thus cause the 
previously active source to be closed

Shortcut
Button :

Keys : CTRL+O

See also File Menu, Source window, Timeline



Encode As command...
Use this command to create an MPEG sequence from the opened AVI source.
The application only encodes the sequence when File/Encode As… is selected, or when the
Encode As  button in the Encoding parameters window is pressed.

Choose the file name and location :
Once File/Encode As... is selected or the Encode As  button is pressed, the 
“Encode as a MPEG file“ dialogue box appears and requests the selection of a filename 
for the MPEG sequence as well as the location where it will be stored.

Create the MPEG sequence :
Once the filename and its path are confirmed, the software begins encoding the 
sequence. This consists of two successive stages. The first one is the creation of the 
elementary audio and video streams. The second stage multiplexes these elementary 
streams to create the MPEG sequence. On completion of the creation process, the 
software indicates its success.

While a sequence is created, a progress bar keeps you informed of the status of the current 
process. A Cancel button allows you to cancel the current operation at any time.

Notes
- Default extension for the generated file is MPG.
- Before running the MPEG compression procedure, you can reconfigure the MPEG 

encoder if you wish to apply different compression parameters from those previously 
defined.

- Availability of sufficient hard disk space is required in order successfully create a 
sequence..

See also Encoding parameters window



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open one of the last 
four documents you closed. Choose the number matching the document you want to open.



Exit command

Use this command to end your software session. You can also use the Close command on the
application Control menu.

Note
During the encoding process, you must press the cancel button in the progress bar before
exiting.

Shortcut
Keys: ALT+F4



Parameters menu commands

The Parameters menu offers the following commands :

Encoding...
Time Unit



Encoding Command
Use this command to display the “ Encoding parameters ” dialog box allowing to configure 
your MPEG encoder :

See also Encoding parameters window

Shortcut
Button :



Time unit sub-menu commands
The Time unit sub-menu allows several time formats for time display and time line of the 
Source window.
These time units are the following:

- In Frames
- In H : M : S : Frames (Hours : Minutes : Seconds : Frames)
- In H : M : S : Milliseconds (Hours : Minutes, Seconds : Milliseconds)

See also Source window, Time display, Time line



Window menu commands

The Window menu offers the following command, which allow to arrange multiple windows 
in the application window:

Cascade



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.



Help menu commands (?)

The Help menu offers the following commands, which provide assistance with this 
application: 

Help Topics
Context Help
About...



Help topics command (Help menu)

Use this command to display the Help contents window. From this window, you can jump to 
step-by-step instructions of use for the software and to various types of reference 
information.

Each time a Help window is opened, you can click the Contents button to access the Help 
Topics window.



About... (Help menu)

Use this command to display the copyright notice and version number of your copy of the 
software.



Source window

The Source window allows you to :
- Open, close a source,
- View the active Source via the virtual VCR,
- Define the current selection by using the selection buttons or the selection time display 

(For AVI file only),
- Open the Encoding parameters window (For AVI file only),
- Check the source format.

See also Virtual VCR, Time display, Time line, Open..., Close.., Selection buttons, Properties
Boutton, Encoding parameters window



Close a Source

Use this command to close the active Source.

Note
When you open a new source the previously active source is automatically closed.
During the encoding process, you must press the cancel button in the progress bar before
closing the source.



Properties button

Use the  button to display information on the format of the active Source. This 
information is displayed in the display screen of Source window as follows:

Note
- Press the Properties button again to return to the normal (frame) display mode.



Virtual VCR
The virtual VCR present in the Source window includes a group of buttons that control the 
current cursor position.

They allow the following operations:
1. Pause : Stops the current play operation and sets the current position cursor to the 

location where the stop was requested
2. Next frame : Moves the current-position cursor forwards by one frame
3. Previous frame : Moves the current-position cursor backwards by one frame
4. Play : Starts video decoding of the sequence from the current position
5. Return to start of sequence : Positions the current-position cursor at the origin of 

the time scale
6. Return to end of sequence : Positions the current-position cursor at the end of the 

sequence.

Notes
- Any movement of the current-position cursor causes decoding and display of the frame 

corresponding to the new position.
- When a button is pressed, its trimming changes from red to green.
- Disabled buttons (Such as "Next frame" when the current-position cursor is at the end of

a sequence) are darker.
- When a Source is playing, the only enabled button is Pause.

See also Source window, Time line



Time line

The time line represents the time axis graduated according to the current time unit. It 
displays the current position marker and the current selection (outlined in pink). The red 
graduations correspond to the beginning and end of the edited sequence.

The current-position marker can be moved in a number of ways :
- By sliding the marker to the desired location using the mouse
- By clicking the arrow buttons of the virtual VCR
- By clicking the graduated zone of the time line. The cursor will move with twice the 

amplitude of the previous method
- By double-clicking the time dispaly of the current position, and by entering the desired 

position in the edition window 

Note
Any movement of the current-position marker causes decoding and display of the frame 
corresponding to the new position

See also Selection buttons, Virtual VCR, Time display, Time unit



Selection buttons

These buttons allow to set the beginning and end of selection markers. These markers are 
used to define the selection to encode

There are two ways of defining the position of a selection marker :
- By clicking one of these buttons directly
- By double-clicking the associated time display and by then entering the desired value in 

the edition window. The current-position marker of the time line is then positioned on 
the new marker

Notes
- Only a valid selection is usable. The selection is valid if the begining of selection comes 

before the end of selection. In this case, it is outlined in pink on the time line.
- By default, when a Source is opened, the entire sequence is selected.

See Also Source Window, Time line, Time display



Time display

The Source window features Time Display windows which display the current playback 
marker position, the beginning of the current selection (In point) and the end of the current 
selection (Out point) positions according to the current time unit. By double-clicking these 
Time Displays, it is possible to specify the desired positions.

See also Source window, Time line, Time unit



Encoding parameters window

This window allows you to :
· Select a constant video bitrate or a constant quantizer scale,
· Select MPEG-1, Video CD or MPEG-2 encoding format,
· Choose to encode a video stream only,
· Select the compression model (Fast, Middle, Full),
· Select the compression option (Interlaced sequence),
· Select the audio bitrate,
· Select the frame rate and the time translation mode,
· Start the encoding process.

See also video bitrate, quantizer scale, MPEG-1, Video-CD, video only, compression model,
compression option, audio bitrate, frame rate, Save as...



Video bitrate and constant quantizer scale
When you select the constant bitrate option, the track represents the video bitrate axis 
graduated in kbit/s.
The video bitrate scale looks as follows :

When you select the variable bitrate option, the track represents the quantizer scale axis 
graduated between 1 and 31.
0 The compression factor heavily depends on the values you assign. If you want more 
compression, assign high value but if you want better picture quality, specify lower value (6 
is medium quality; 2-3 is high quality).
The quantizer scale looks as follows :

The current-position marker can be moved in a number of ways :
- By sliding the marker using the mouse to the desired location
- By entering the desired position in the edition window

Note
In case of constant bitrate, the recommended video bitrate range is outlined in yellow on 

the video bitrate scale.



MPEG-1

Choose this option if you want to generate a MPEG-1 sequence. Default choice is MPEG-2.



Video CD

Choose this option if you want to generate a Video CD sequence.



Video only

Choose this option if you only want to encode the video stream.



Compression model

A MPEG Video sequence consists of the three following types of frames :
· I-Frames (Intra), encoded without reference to other frames
· P-Frames (Predictive), depend on the previous I-Frame or P-Frame
· B-Frames (Bi-directional), depend on the previous and following frames

Fast mode : The MPEG sequence is composed of I frames.
Middle mode : The MPEG sequence is composed of I and P frames (GOP :IPPPPPPPPPPPP).
Full mode : The MPEG sequence is composed of I,P and B frames (GOP :IBBPBBPBBPBBP).



Compression option

Interlaced original sequences:    
Most capture boards offer two distinct encoding mode:
The progressive mode and the interlaced mode.
The progressive mode consists of capturing all the lines of one frame at the same time 
(Video Capture Frequency: PAL 25 Hz, NTSC 29.97 Hz).
The interlaced mode consists of capturing the even lines and odd lines at different times 
(Video Capture Frequency: PAL 50 Hz, NTSC 59.94 Hz).    Therefore an interlaced sequence is 
made of a series of odd frames and even frames.
The interlaced mode is the most often used in video capture.

Frame Inversion:    
This option must be activated if your original source sequence is interlaced and if the odd    
frame is captured BEFORE the even frame.
We strongly suggest you test this option if you own an AVI capture board !



Audio bitrate

Only the following values (in kbits/second) can be used: 
for Single-channel: 32, 48, 56, 80, 64, 96, 112, 128, 160, 192
for Stereo-channel: 64, 96, 112, 128, 160, 192, 224, 256, 320, 384

The following information about the compression parameters is also provided: 
- MPEG compression algorithm (Layer II)

Mono or stereo mode.

MPEG Maker 2 only accepts audio stream having the following properties:
 Sampling frequency: 11.025KHz or 22.05KHz or 44.1 KHz or 32 KHz or 48 KHz



Frame rate

This sets the number of frames per second of the MPEG video stream. Select 25 for 
PAL/SECAM compatible MPEG files or 29.97(color) or 30(b&w) if you want NTSC compatible 
files.
The result also depends on the number of pictures per second in the AVI source file: If the 
AVI is 15 Fps and you compress it to a 30 Fps MPEG file with keep original playback duration 
checked, MPEG Maker will perform a time translation (by copying each image from the AVI 
file twice in the MPEG file). The resulting file will be 15fps if played with a real-time MPEG 
decoder. Select keep original number of pictures option if you do not need real-time 
playback.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcut
Keys: CTRL+F4 closes a window

ALT+F4 closes the window or dialog box



Restore command (Control menu)

Use this command to restore the active window to its size and position before you chose to 
Maximize or Minimize it.



Context Help command

Use the Context Help command to obtain help on a specific part of the software. Press 
SHIFT+F1, the mouse pointer will turn to an arrow and question mark. Click then somewhere
in the software window. The Help topic for the item you clicked will be displayed.

Shortcut
Keys: SHIFT+F1



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to a four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 

pointer to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Notes
- This command is unavailable if the window has been maximized.
- Only the main window can be resized.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note
This command is unavailable if the window has been maximized.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the active window to an icon.

Shortcut
Mouse: Click the minimize icon  on the title bar.

Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.
This command is available only for the main window.

Shortcut
Mouse: Click the maximize icon    on the title bar  or double-click the title bar.

Keys: CTRL+F10



Title Bar

The title bar is located at the top of a window. It contains the name of the application or of 
the active file.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
- Application Control-menu button
- Active Source Control-menu button
- Maximize button
- Minimize button
- Name of the application
- Name of the active Project or the active Source
- Restore button



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




